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Looking into the future has fascinated mankind for ages. With the advent of sufficiently powerful personal computers, we do not need a crystal ball anymore to foresee what our country will look like in, say, 30 years from now. All that is needed now to simulate future spatial developments is a set of spatial data, modelling software and some thoughts on which spatial developments you expect are going to happen in the coming decades. The latter is of course the tricky part. By looking at current developments we may distil trends that are likely to continue for the coming 5 to 10 years. Yet, looking much further is risky at best as many uncertainties prevail. Will population growth come to halt? Will economic development be slow? Will society prefer ecological sustainability or economic prosperity? How will government try to steer spatial developments? Will they succeed?
   [image: cbpink]
Simulating the future has only recently become part of science




A popular approach to deal with uncertainties relating to future spatial developments is the use of scenarios. By describing several opposing views on the future we can simulate a broad range of spatial developments, thus offering a full overview of possible land-use alterations. Each individual outlook on the future will not necessarily contain the most likely prospects, but together the simulations may provide the bandwidth of possible land-use changes. The individual scenarios should in fact not strive to be as probable as possible but should stir the imagination and broaden the view of the future. Important elements are: plausible unexpectedness and informational vividness (Xiang and Clarke, 2003). 

In this assignment, you are asked to simulate future land use for the Netherlands with an actual land-use model according to a specific scenario of socio-economic developments. First, we will introduce the Land Use Scanner model that you are going to use. After this introduction, you will explore the model in a hands-on exercise. When you are familiar with the model’s main functions, you will start the actual assignment. 




















For more information about Land Use Scanner, the full model and its applications, you can visit the website (https://spinlab.vu.nl) or contact Eric Koomen (e.koomen@vu.nl).

Introducing Land Use Scanner
[bookmark: _Hlk124851818]In this assignment, you will use Land Use Scanner, an integrated land-use model that has been used for many research and policy-related projects. The model was developed by a range of partners that include Vrije Universiteit Amsterdam and the Netherlands Environmental Assessment Agency PBL. Early applications include, among others, the simulation of future land use following different scenarios (e.g., Borsboom-van Beurden et al., 2007) and the evaluation of alternative locations for a new national airport (Scholten et al., 1999). The model has been used in many outlooks on the future relating to a range of planning themes, such as: water management (De Moel et al., 2011); climate change (Claassens et al., 2020, Koomen & Diogo, 2017); the prospects of agricultural land use in the Netherlands (Diogo et al., 2015); and the development and evaluation of regional spatial strategies (Koomen et al., 2011). Apart from these Dutch applications, the model has also been applied in several European countries (Hoymann, 2010; Te Linde et al., 2011; Schotten et al., 2001). 

The GeoDMS framework underlying Land Use Scanner is developed and maintained by the ObjectVision company and also applied in other spatially explicit models. Examples include a land-use modelling framework for the European Commission that covers all member states of the European Union at a 100-metres resolution (Lavalle et al., 2011) and the 2UP model that simulates urban development and population change around the globe (Koomen et al., 2023). A full account of the original Land Use Scanner is provided by Hilferink and Rietveld (1999), whereas a revised version and several applications are documented in a book by Koomen and Borsboom-van Beurden (2011). For a more extensive overview of publications related to the model visit https://spinlab.vu.nl.

Land Use Scanner is a GIS-based model that simulates future land use. Unlike many other land-use models its objective is not to forecast the dimension of land-use change but rather to integrate and allocate future land-use claims from different sector-specific models. The model offers an integrated view on all types of land use. It deals with urban, natural and agricultural functions, normally distinguishing 10 or more different land-use categories. The model is grid-based, and this Student Edition covers the Netherlands at a 100 by 100 metres resolution (with over 9 million cells in total and about 3.3 million referring to the Dutch land territory)[footnoteRef:1].  [1:  This demo version also contains a coarser (500 metres) representation of land use for users with old and slow computers. This coarse resolution can be activated by specifying 500m as ModelResolution in the ModelParameters settings in the demo.dms file.] 


In the provided model version, each cell describes the relative proportion of all land-use types present at a location. So, a cell can contain more than one type of land use, presenting a highly disaggregated description of the whole country. An individual cell with a 100m-resolution can, for example, have the following composition:
			residential	0.4 ha		building lot	0.0 ha
			industrial	0.0 ha		infrastructure	0.1 ha
			recreation	0.2 ha		water		0.3 ha
			agriculture	0.0 ha		exterior	  	0.0 ha
			nature		0.0 ha		Total	=	1.0 ha

To provide a simple, single visualisation of this disaggregated description of land use, maps of predominant land use are created. Keep in mind, however, that this representation may be a bit misleading. In the example-cell introduced above, residential land use is dominant with only 0.3 hectares (less than half) of the total surface area of the cell (1 hectare). With nine land-use classes the predominant land use may cover as little as 0.2 hectares in a cell.

In addition to land-use data, the model contains many different spatial data sets and other elements that are organised in four main folders: 
1. Model parameters; an overview of model settings (e.g., resolution) that we will not adapt.
2. Current situation; a collection of spatial data sets that describe the current situation.
3. Scenario components; the definition of the future scenarios that will be simulated.
4. Simulations; the land-use maps and other outcomes that result from simulation.

The following sections describe the content and relevance of the elements you will adapt in this assignment.

Current situation
In Land Use Scanner the current situation refers to current land use and other data sets describe the current situation of important drivers of land-use change. These data sources can be used to define local suitability. They are grouped into the following subfolders: 
· Current land use describing nine aggregate land-use classes for 2017.
· Policy maps showing operative (government) policies based on restrictions (yes or no).
· Thematic maps showing location characteristics such as attractiveness of urban environments, physical characteristics (e.g., landscape quality or altitude), accessibility or safety issues.
· Distance decay maps that describe the presence of specific land-use types and two nature policy areas within different distance ranges.

Scenario components
In the model scenarios of possible future developments can be constructed using the following components: 1) local suitability; 2) regional demand; and 3) exogenous developments. These aspects are further introduced below.

	Local suitability
Suitability is a crucial component in the allocation of future land use. This suitability of a location (grid cell) can be interpreted as the net benefits that a land-use function derives from that specific location and are expressed in Euros per square metre. A high suitability for a certain land-use type at a particular location leads to a high probability that this land-use type gets allocated there. The value of a grid cell in a suitability map can also be negative indicating that the cell is highly unsuitable for a certain land use. 

For every location, the suitability or attractiveness for the different land-use types is described, based on several site-specific characteristics. The factors influencing this suitability are divided into the aforementioned four groups: 
a) current land use;
b) policy maps; 
c) thematic maps; and
d) distance decay maps.

Reference to current land use is added because the allocation process does not automatically retain this. In contrast to many other land use models, Land Use Scanner starts simulation with an empty map. To account for the fact that land use has a certain inertia (e.g., due to the cost of converting land from one use to another) we include reference to current land use in the definition of suitable locations. The importance of each contributing factor is dependent on the scenario and weighted in a script, as will be explained in the exercise. 

	Regional demand
Sector-specific models of specialized institutes, such as housing and employment models, provide the regional projections of land-use change that are used as input for the Land Use Scanner model. These are called regional demand or claim sets in the model.

	Exogenous land use
The spatial developments of a number of specific land-use types (infrastructure, water and exterior) are not simulated through the allocation module, because they are either absent or have a very confined, local appearance. These normally only constitute of planned additions to the infrastructure network, that are directly (exogenously) inserted in the simulation outcomes. The remaining land-use types are simulated within the model and are referred to as endogenous land-use types.

Simulations of future land use
The demand for land is matched with the supply of suitable land, resulting in a simulated future land use for each grid cell. This process is called allocation (Figure 1). Land Use Scanner is able to use two different descriptions of land use per cell in the allocation process: 
1. a continuous description using heterogeneous cells to indicate the amount of land for each land-use type present at a specific location (as was explained previously). 
2. a discrete description using homogenous cells to indicate the single dominant land use at a particular location. 

Each description of land use has its own allocation procedure. The continuous allocation uses a logit function to calculate the most probable land use at that location, whereas the discrete allocation uses a spatial optimization procedure that is solved through a form of linear programming. Appendix 1 briefly explains these different allocation procedures.

This assignment uses the continuous allocation procedure, but the discrete allocation procedure is also included in the provided model version to allow comparison between the different approaches. The outcomes of the continuous model version can be interpreted as the expected proportions of land to be used for the various types of land use. The predominant land-use maps depicting a single dominant land use per cell from these calculation results are visually similar to the outcomes of the discrete allocation process that - by definition - results in one land use type per grid cell. 

[image: RS_schema_LUSdemo2012_gb]
Figure 1 - Basic layout Land Use Scanner model.


Exercise – Getting to know Land Use Scanner 
To familiarize yourself with the Land Use Scanner model we first ask you to go through this simple exercise. Read the exercise carefully before you start the assignment! After having completed all steps, you should understand the basic functions of the model and know how to use them.

Getting started
Start the Land Use Scanner model. The model should now display the following elements: 
· The menu bar with several pull-down menus.
· A currently empty dark-grey toolbar that can contain window-specific tools.
· On the left-hand side a TreeView that allows you to navigate through the spatial data collection.
· A currently empty light-grey data view area in the middle (for displaying tables and maps). 
· On the right-hand side a details page where you can inspect all kinds of model and data details that is best closed for now by pressing Alt+1 (or by unchecking the Details pages option in the pull-down menu called View).
· At the bottom a status bar that can present hints and status information.

We will concentrate on the TreeView ase that provides the easiest access to the model.

Viewing spatial data
Land Use Scanner contains a number of spatial data sets. These can be viewed by browsing through the TreeView.
1. Start by clicking on the + in front of the container (directory) called “Current_situation” and again on the + in front of the subsequent “Current_landuse” container. This container includes nine data layers that describe the land use in the year 2017. The small globes [[image: ]] indicate that a map of the data layers can now be drawn in the data-view area.

2. View several individual land-use layers (e.g., residential or industrial land use) by trying out the two ways to draw a map view: 
· by double-clicking on any of the data layer names. This option allows multiple data layers to be drawn in the same map view window. Note that maps are drawn as transparent layers. This has the advantage that you can visually compare two layers but makes the colours more difficult to interpret. You can switch layers on and off by double-clicking on them in the legend window on the right-hand side.
· by activating (clicking on) the data layer and then simultaneously pressing the Ctrl-M key combination or by giving a right mouse click on the data layer and selecting the Map View-option from the appearing menu. This option will open a new map view window for every data layer.

When you view a current land use layer, a legend appears on the right-hand side that indicates the number of hectares (ha, here called 10 kilo m^2) and that values range from 0 to 1, the maximum value for the 100x100-metres grid cells. A last column in this legend contains the count (i.e., number of cells) for each class. Right mouse-click on the legend area. This allows you to select the statistics function in the appearing menu, providing you with some basic statistics on the selected land-use function. 

The individual land-use maps do not offer a coherent view on land use in the country so we will try out a different way of looking at these data layers. Close all opened map views (menu option Window > Close All) and then click on the data layer “Predominant”. This layer describes predominant land use per cell (Figure 2). This map shows for every grid-cell the land-use function that covers the most hectares. It clearly indicates the most notable features of the country: a network of big cities in the west of the country, a number of large nature areas along the coast and in the middle of the country, and lots (two-thirds of the land surface!) of agricultural land in between.

3. [image: ]The toolbar contains several standard GIS-functions that allow you to adapt your data view and export images: 

The purpose of the buttons is explained when you hoover over them with your cursor. Explore these functions to understand their possibilities and see how you can remove the panels in view area to adjust the interface to suit your taste and interest. Clicking on the map (when the zoom functions are not active) allows you to inspect local value as the information button in standard GIS allows you to do. The selected value shows up in the map legend. The options to copy the active view (map window and legend windows on the right) or just the legends of the active layers are helpful if you want to generate graphics for a presentation or report. 

[image: ]
Figure 2 - Dominant land use in the Netherlands for the year 2017 as shown in the Land Use Scanner demo user interface.

4. Land Use Scanner also contains a collection of spatial data sets that are relevant for the simulation of future land use. These sets are considered when suitability is defined. 

Take 10 minutes to browse through the containers containing policy maps, thematic maps and distance decay maps. See the description of all available data layers in Appendix 3 for information about what the available data sets represent.

Defining suitability
We will now inspect the way suitability for different land-use types is included in the model. 
1. Start by opening the A1_GE scenario in the Scenario_Components > Local_Suitability container. Then view the Residential land-use suitability map and write down the minimum and maximum values you find in the statistics. Zoom in at city level and save a bitmap of that particular situation.
2. Inspect the definition of the suitability map that you opened by right-clicking on the appropriate data layer and selecting the edit config source option. You may also hit the Crtl+E keys after selecting the data layer. This will open a text editor at the line of the script that defines the data layer you just opened. Note that this option will only work when you properly refer to the text editor of your choice. This reference is made in the Advanced settings tab in the Options menu available from the pull-down menu option Tools (Figure 3). The Advanced settings tab is only visible when you activate ‘Show hidden items’ in the GUI tab of the Options menu. By default, reference to the Notepad++ editor (available from https://notepad-plus-plus.org/downloads/) is included in the GeoDMS. The appropriate line number and file name are provided by the GeoDMS to the editor by means of the parameters (%F -n%L). Make sure that the correct pathname (and name of .exe file) is used to refer to the location where the editor is installed. You can also refer to another text editor. The following line, for example, refers to a standard windows text editor: c:\windows\system32\notepad.exe "%F" . Note that this reference may be different on your specific computer. For more information consult this webpage: https://www.geodms.nl/Configuration_File_Editor. 

If you have difficulty with the steps above, you can also open a text editor of your choice and open the script file you want to edit within that editor. In this exploratory exercise, we will work with the A1.dms file located in the lus_demo_2023\cfg\demo\ScenarioComponents\ folder you have created somewhere on your PC.
[image: ]
Figure 3 - Options Menu.

3. The suitability maps of all land-use types of a scenario are defined in a single compact text file that holds the scenario name. It contains a header and a series of text lines relating to the actual suitability of the various land-use functions. See for example the suitability script of the residential land-use function (Figure 4).
[image: ]
	Figure 4 - Part of the A1.dms suitability script with the suitability values encircled.

A function’s suitability is separated into values related to:
a) current land use;
b) policy maps; 
c) thematic maps, and
d) distance decay maps. 

Note that most available spatial datasets are included in the script but, apart from the one that relates to current land use, all values (the encircled numbers) are set to zero. This means that the suitability for a specific land-use function is currently only related to present land use. This is a good start because we normally want to preserve land-use functions at their current location. Remember that we will simulate the total of current land use and additional claims on a blank map. To include the preferred locations for the future development of specific land-use functions, we will however need to add values to the relevant datasets. Doing this in a structured way that is coherent with the storyline of the scenario is the objective of the upcoming assignment. For now, we will only practice adjusting the script.

Please only adjust the values in the encircled area, so do not for example change the km or Percent values at the end of the lines. You may, however, also change the signs of the values in front of the lines, indicating whether a map increases (“ + value ”) or decreases (“ – value ”) the suitability of a location for a specific land-use function. Take care, though, that we have added these signs with a certain logic in mind.

As a guideline, you can use the following values for indicating the importance of the various datasets/policies/maps:
	Importance
	Value

	Not important
	0.0

	Somewhat important
	1.0

	Important
	3.0

	Very important
	5.0



You are free to choose values outside this proposed range. For example, if you want to stress the importance of a specific data layer, you could set its value to 15.0 and see what the effect is on your simulation result. Keep in mind that the total suitability is calculated as the sum of all values you associated with the data layers you considered important for this land-use type. So, you should balance the weights between all layers you find important. It does not make sense to provide high weights to all layers, as that does not differentiate between locations. It is better to be selective and only value the layers that are really important. A final aspect to consider is that Land Use Scanner uses suitability in an exponential function and very high values will cause a numerical overflow error and will stop simulation. Therefore, try to keep the sum of values given to the different layers for a land-use type at any given location between –20 and +40 Euro per m2, as the legend of the suitability maps also indicates.

Scroll down to the part of the A1.dms script that relates to the function Residential land use, which is indicated by the heading with the word RESIDENTIAL in capitals. Change the values for residential spatial plans and attractiveness surroundings (indicating the public appreciation of the surrounding landscape) from 0 to 5. Make sure you save the changes you made.

Reopen Land Use Scanner by hitting the ALT and R keys simultaneously or by going to the File dropdown menu, choose open configuration file, and select the demo.dms file. DO NOT SAVE THE CHANGES MADE TO THE CURRENT DEMO.DMS FILE! Saving will create a complete copy of the configuration including all data sources and thus lead to unwanted consumption of disk space. Reopening Land Use Scanner allows the model to take your update in the scenario script into account. You can now redraw the changed suitability map for residential land use in the A1 scenario. This map should include the plans for residential extensions and an indication for attractive landscapes. 

Compare the current minimum and maximum values with the original ones that you wrote down in step 1. Have the values changed as you expected them to? Also, check whether the pattern reflects that of the underlying data-layers by adding these to the map view and compare it with the saved bitmap.



Other scenario components
Apart from suitability, scenarios are defined through their exogenous land-use developments and regional land demand.
1. The container Scenarios > Exogenous_Landuse > A1_GE contains the expected future locations of the land-use types that are not simulated. In this version, we do not expect these to change, but this option allows inserting, for example, new infrastructure developments or the inclusion of new waterways. 

2. Each land-use type has its future area demand and this may vary for each scenario. For example, in a scenario with higher population growth, more space will be needed for residential areas, thus the land-use demand (in hectares) for residential land use will be higher. The container Scenario_Components > Regional_Demand > A1_GE > Additional_Claims lists for each land-use type the area that is expected to added be between 2017 and 2040 based on the scenario assumptions.

Right click on the map residential_claim and select Table View (shortcut: press Ctrl-D). A table will be displayed in the DataView listing the land-use claims for three regions. Close (exit) the table in DataView and then doubleclick on the item in the TreeView to view the map of the claims. It is not necessary for all land-use claims to balance out (add up to exactly 0). The model is able to cope with over-demand or over-supply of land.


Simulating future land use
1. In the TreeView, click on Simulations > A1_GE > Results > Continuous (i.e., the results following from the continuous allocation algorithm). When you open this container, you will see two subcontainers: LandUse and Evaluation. The container LandUse contains result maps of all nine land-use types for 2040 (subdivided in two subcontainers: Endogenous and Exogenous land use) and a map with the predominant land use per cell only. You can, for example, compare the maps of predominant land use in 2040 with the map of predominant land use in 2017.

2. The container evaluation contains a set of evaluation measures for different spatial scale levels, which are described below:
· Total: Four table-containers describing national totals in current land use, total demand, allocated land use and the fraction of demand that was realised.
· Regional: Double-click on the container-label AllocatedLanduse and a table listing allocated land use in hectares will be drawn in the DataView. 
Copy-Paste the contents of this table to Excel by clicking on the Copy-Paste icon in the Toolbar  [image: ]  and then selecting Edit > Paste (or CTRL+V) in Excel. Using both current and allocated land use, you can numerically see the differences between the endogenous land use in 2017 and in 2040, calculate percentages et cetera.
· Local: The container DifferenceMaps contains maps that show grid-cell specific differences between 2040 and 2017 for the six simulated land-use types.
The container Urbanisation contains several evaluation measures that were developed specifically for analysing the effects of urbanisation (see Ritsema van Eck and Koomen, 2008, for more details). The indicators describe: 
-	urban development, by creating maps of current and allocated built-up areas and calculating a difference map;
-	urban pressure on nature and landscape, distinguishing pressure on the National Ecological Network (netEHS), BirdHabitat areas, or high-quality landscapes. 
· Floodrisk: This set of indicators describes the potential damage that arises from flooding. These calculations build upon land-use specific damage functions that link land use and expected water depth to potential damage in Euros per hectare. Damage is calculated for individual grid cells based on predominant land use and aggregated to flood risk management zones (dike rings). By comparing current and simulated land-use based damage per region an indication is obtained of the potential increase in damage due to land-use change. This change ratio is applied to expert-based damage assessments for the current situation to obtain a more accurate estimate of potential future damage. Similar calculations are applied in many research projects and policy evaluation studies (e.g., de Moel et al, 2011). A more detailed description of the calculation process is provided elsewhere (e.g., Bubeck and Koomen, 2008).

3. Familiarise yourself with these evaluation measures by opening several maps, and see if you understand the values of the maps you open. As soon as you draw the map of predominant land use in 2040 or use one of the evaluation measures, the model will run the scenario and calculate the results. This may take several minutes. After the results have been calculated, they are kept in memory and therefore opening other evaluation measures or displaying other allocated land use will go much faster.

Closing a session
In the menu-bar, click on File > Exit and do not save the changes made to the current demo.dms file!

Assignments – Modelling the future of the Netherlands
Now you are familiar with the model, it is time to bring this new-found knowledge into practice. You are provided with a fully functional copy of Land Use Scanner that already contains a basic reference to four socio-economic scenarios (see Appendix 2 for a description). Scenario-specific land-use claims have been added to the model and all available spatial datasets are included in the suitability maps. No weights have been added to these maps, however. The land-use demands, and suitability maps are combined in the allocation module and results are available from the Simulations container.

It is your task to simulate the future of the Netherlands according to a specific scenario or policy alternative. For this assignment you are asked to either:
1. simulate land-use patterns according to one of the four scenarios by selecting and weighing the various components of the suitability maps in order to match the storylines of the scenarios; or
2. optimise land-use patterns according to specific policy objectives by adjusting the suitability maps and possibly also the demand for land.

The two different assignments are described below.


The final result of the is assignment is a group presentation in which you will discuss the land-use simulation results you created. The presentation will be evaluated based on the criteria listed in the table below.

Table 1 - Evaluation criteria for the presentation you will deliver to finalise the assignment
	Criteria
	Weight
	Explanation

	1 – Content
	40
	Content of your presentation; do you present the right maps, do you show understanding of specific model components, the simulation process and the way results should be interpreted?

	2 – Originality
	10
	Do you come up with original results in your analysis, include original evaluation measures/indicators, or apply an innovative viewpoint from which you have developed your scenario?

	3 – Presentation
	10
	General presentation skills: eye contact with your audience, using your voice properly, et cetera.

	4 – Reflection
	40
	Do you include critical reflection on the modelling approach, model aspects and the assignment in general in your presentation? Does your reflection make sense?

	
	100
	






Assignment 1. Simulate land use according to a scenario 
To generate maps related to Dutch land use in 2040 in a specific scenario, we request you do the following:

1) All group-members should take a look at the list with available spatial data as included in Table 2. A more detailed description of each data layer is included in Appendix 3. 
	In this table, indicate individually which themes are relevant for your specific scenario in general (for all land-use types) based on the scenario descriptions included in Appendix 2. Then select what spatial data sets can be used to represent a theme and specify the relevance of each dataset for each individual land-use type on a scale from 1 (minor importance) to 5 (extremely important). Non-relevant datasets should keep the value 0.
2) Discuss the possibly conflicting views on the relevance of the spatial datasets in your group and decide upon a joint valuation of the components that make up your suitability maps. 
3) The next step is to actually adjust the suitability maps for all individual land-use types in your scenario. You can do this by changing the appropriate values in the scenario-script (e.g., A1.dms) in the text editor. As a start you can use the values that you agreed upon in the previous step.
	Keep in mind that the total suitability value of a land-use type reflects the net benefits of a certain location for that specific land-use type. This should provide a rationale (as well as limits) for your range of suitability values. Keep the range between -20 and +40.
	Finally, save the script and restart Land Use Scanner.
4) Take a look at the resulting suitability maps per land-use function and discuss whether these are coherent with your initial thoughts on the scenario. Results can be analysed by comparing saved bitmaps and statistics of the situation before and after you change the script.
5) Simulate future land use by running the appropriate simulation (e.g., Simulations > A1_GE). Check the resulting maps on consistency with the storylines of scenario, e.g., by making maps that depict dominant land use and the changes from current land use. Discuss which adjustments are needed.
6) Adjust the suitability maps and rerun the model until the results correspond with your views on the scenario.
7) Summarize the results by making characteristic maps of future land use. Make use of the possibilities for creating evaluation maps that describe dominant land use, the changes as compared to the current situation and impacts on natural areas and landscape values. You can export maps by right-clicking a layer to, for example, ArcGIS, to create more elaborate impact assessments and/or more refined maps.
8) Prepare a Powerpoint-presentation of 8 minutes with your group in which you offer your selection of relevant maps. Discuss the results in terms of: the rationale for the weights you applied to the suitability data layers, their coherence with storylines, the validity of your results, possible shortcomings in the simulation process, and its general usefulness for policy-purposes. 




Assignment 2. Optimise land use according to a set of policy objectives 
The Land Use Scanner model is also able to optimise land-use patterns according to specific, spatially explicit policy objectives (see, for example, Koomen et al., 2011). In this assignment you are asked to consider one of the following three different objectives: 
a. water management (protecting the hydrological cycle, land use follows hydrological conditions et cetera); 
b. safety and public health (limiting all kinds of risk to society); or
c. nature conservation (preserving biodiversity and strengthening the nature network).

To optimise Dutch land use in 2040 according to one of these objectives you will start to work with the land demand following the A1_GE-scenario. This is an arbitrary choice as the policy objectives are not directly related to the scenario assumptions, but selecting the A1-scenario has the advantage that a substantial amount of land-use change occurs making it easier to see the impact of your choices. One could argue that optimised land-use patterns according to this scenario prepare policy makers for worst case conditions: you try to meet specific objectives under conditions of substantial urban growth. 

We ask you to follow the steps below:

1. All group-members should take a look at the list with available spatial data as included in Table 2. A more detailed description of each data layer is included in Appendix 3. 
	Define for yourself what you consider to be important spatially explicit policy measures to improve land-use patterns according to the general objective of your choice. Then select what spatial data sets can be used to put your specific policy objective interpretation into practice. In Table 2, specify the relevance of each dataset for each individual land-use type on a scale from 1 (minor importance) to 5 (extremely important). Note that the data-layers that are important for a policy alternative in general are not necessarily relevant for all individual land-use types. Some data-layers will be important for urban functions others for nature etcetera. Non-relevant datasets should keep the value 0.
2. Discuss the possibly conflicting views on the relevance of the spatial datasets in your group and decide upon a joint valuation of the components that make up your suitability maps. 
3. The next step is to actually adjust the suitability maps for all individual land-use types in your policy alternative. You can do this by changing the appropriate values in the scenario-script (i.e. A1.dms) in the text editor. As a start you can use the values that you agreed upon in the previous step. Keep the range of your total suitability value between -20 and +40.
	Finally, save the script and restart Land Use Scanner. 
4. Take a look at the resulting suitability maps per land-use function and discuss whether these are coherent with your initial thoughts on the policy objective. Results can be analysed by comparing saved bitmaps and statistics of the situation before and after you change the script.
5. Simulate future land use by running the appropriate simulation (in Simulations > A1_GE). Check the resulting maps on consistency with the policy objectives, e.g., by making maps that depict dominant land use and the changes from the current land use. Discuss which adjustments are needed.
6. Adjust the suitability maps and rerun the model until the results correspond with your views on the policy objective.
7. In order to meet your policy objectives, you can also consider the implementation of policy measures that change the demand for land (e.g., limit the amount of urban land by prescribing higher building densities, or expand the demand for nature by launching a more ambitious nature development programme). Discuss such options in your group and decide upon a justifiable change in demand. You can implement the changed demand in the csv-files in ..\ProjDir\Lus_demo_2023\data\Scenarioclaims\. For each land-use type, the amount of additional land that will be added to 2017 land use per region and per scenario is specified here. 
Note You may ignore the Current-scenario. You can type the changed demand directly in the 	file in a text editor, or open the csv-file in Excel and make your changes there. 
Note Make sure you change figures in the A1 columns as this is the base-scenario you use in your optimisation.
8. Once you have changed the demand you can rerun the simulation (after re-opening Land Use Scanner) and discuss whether the results match your expectations. 
9. Summarize the results by making characteristic maps of future land use. Make use of the possibilities for creating evaluation maps that describe dominant land use, the changes as compared to the current situation and impacts on natural areas and landscape values. You can export maps to, for example, ArcGIS, to create more elaborate impact assessments and/or more refined maps.
10. Prepare a Powerpoint-presentation of 8 minutes with your group in which you offer your selection of relevant maps. Discuss the results in terms of: the rationale for the weights you applied to the suitability data layers, their coherence with the policy objectives, the validity of your results, possible shortcomings in the simulation process, and its general usefulness for policy-purposes. 

Table 2 - List of suitability factors
	
	
	Values in scenario script

	Main group / Theme
	Data layer
	Residential
	Industrial
	Recreation
	Nature
	Agricult.

	Policy_maps
	
	
	
	

	Spatial_plans
	Residential
	
	
	
	
	

	
	Industrial
	
	
	
	
	

	
	Recreation
	
	
	
	
	

	NatureLandscape
	BirdHabitat
	
	
	
	
	

	
	Net_EHS03
	
	
	
	
	

	Water
	Intake_reservoir
	
	
	
	
	

	
	Disaster_retention
	
	
	
	
	

	
	Space_for_rivers
	
	
	
	
	

	
	Groundwater_protection
	
	
	
	
	

	
	Groundwater_intrusion
	
	
	
	
	

	Thematic_maps

	Residential
	UrbanAttractiveness
	
	
	
	
	

	
	AttractiveSurroundings
	
	
	
	
	

	Accessibility
	Dist_mainports
	
	
	
	
	

	
	Dist_TrainStation
	
	
	
	
	

	
	Dist_HighwayEntry
	
	
	
	
	

	
	Dist_100000inh
	
	
	
	
	

	
	Dist_100000jobs
	
	
	
	
	

	Noise
	Perc_opp_gt_50dba
	
	
	
	
	

	NatureLandscape
	Landscape_quality4K
	
	
	
	
	

	
	Landscape_experience
	
	
	
	
	

	
	Altitude
	
	
	
	
	

	Safety
	Flood water depth
	
	
	
	
	

	
	Earthquakes
	
	
	
	
	

	
	Dangerous sites
	
	
	
	
	

	
	Dangerous transport
	
	
	
	
	

	Distance_decay
	
	
	
	

	LandUse2000
	Amount of specific 
land-use types in range
of 1, 5, 25 or 50 km
	
	
	
	
	

	PolicyMaps
	Amount of BirdHabitat 
area within 1km
	
	
	
	
	

	
	Amount of net_EHS03 
area within 1km
	
	
	
	
	


Note Building lots supply ready-to-build land to urban types of use. Since it only supplies land and no new building lots are created in simulation, the total area of this land-use type will decrease to around 0 hectares in most scenarios. In scenarios with limited demand for new developments building lots may remain vacant at their current locations. Therefore, you do not need to fill in suitability values for building lots.
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Appendix 1	Land Use Scanner Background
Land Use Scanner employs two approaches to simulate the probability that a certain location is chosen for a specific land use. These two approaches, continuous and discrete, are described below in different paragraphs. An extensive discussion on both allocation approaches and a comparison of their performance is provided in a report by Loonen and Koomen (2009).

A crucial variable for both approaches is the suitability scj for land use of type j in grid cell c. This suitability can be interpreted to represent the net benefits (benefits minus costs) of land-use type j in cell c. The higher the benefits (suitability) for land-use type j, the higher the probability that the cell will be used for this type. The economic rationale that motivates this choice behaviour resembles the actual functioning of the land market. The model is furthermore constrained by two conditions: the overall demand for the land-use functions which is given in the initial claims and the total amount of land which is available for each function. 

Continuous allocation
The original, continuous model employs a logit-type approach, derived from discrete choice theory. Nobel prize winner McFadden has made important contributions to this approach of modelling choices between mutually exclusive alternatives. In this theory, the probability that an individual selects a certain alternative is dependent on the utility of that specific alternative, in relation to the total utility of all alternatives. This probability is, given its definition, expressed as a value between 0 and 1, but it will never reach these extremes. When translated into land use, this approach explains the probability of a certain type of land use at a certain location, based on the utility of that location for that specific type of use, in relation to the total utility of all possible uses. The utility of a location is in our case expressed as the suitability for a certain use. In combination with the constraints related to demand for land and the amount of available land per cell the following doubly constrained logit-model can be formulated: 




In which:
Mcj	is the expected amount of land in cell c that will be used for land-use type j.
aj	is the demand balancing factor that ensures that the total amount of allocated land for land-use type j equals the sector-specific claim.
bc	is the supply balancing factor that makes sure the total amount of allocated land in cell c does not exceed the amount of land that is available for that particular cell.
· is a parameter that allows for the tuning of the model. A high value for  makes the suitability more important in the allocation and will lead to a more mixed-use land pattern, strongly following the suitability pattern. A low value will produce a more homogenous land-use pattern. Normally  is set at 1.
e	is the base for natural logarithms (=2.71828).
scj	is the suitability of cell c for land-use type j, based on its physical properties, operative policies and neighbourhood relations.

The outcomes of the model are thus based on various external model results, a probability approach and many operational choices of the model user. The results should therefore not be interpreted as an exact prediction for a particular location but rather as a probable spatial pattern of land-use change.



Discrete allocation
The discrete allocation approach allocates equal units of land (cells) to those land-use types that have the highest suitability, taking into account the regional land-use demand. This discrete allocation problem is solved through a form of linear programming. The solution of which is considered optimal when the sum of all suitability values corresponding to the allocated land use is maximal. 

This allocation is subject to the following constraints:
· The amount of land allocated to a cell cannot be negative;
· In total only 1 hectare can be allocated to a cell; and
· The total amount of land allocated to a specific land-use type in a region should be between the minimum and maximum claim for that region.

Mathematically, we can formulate the allocation problem as:




subject to: 

 for each c and j;

 for each c;

 for each j and r for which claims are specified;

in which:
Xcj	is the amount of land allocated to cell c to be used for land-use type j;
Scj	is the suitability of cell c for land-use type j;
Ljr	is the minimum claim for land-use type j in region r; and
Hjr	is the maximum claim for land-use type j in region r.

The regions for which the claims are specified may partially overlap, but for each land-use type j, a grid cell c can only be related to one pair of minimum and maximum claims. Since all of these constraints relate Xcj to one minimum claim, one maximum claim (which cannot both be binding) and one grid cell with a capacity of 1 hectare, it follows that if all minimum and maximum claims are integers and feasible solutions exist, the set of optimal solutions is not empty and cornered by basic solutions in which each Xcj is either 0 or 1 hectare.




Appendix 2	Description of the four scenarios
The assignment refers to four scenarios for future spatial developments, initially described in the 'Welfare, prosperity and quality of the living environment' (WLO) scenario study (CPB et al., 2006). They provide a coherent framework for studying the distinguished developments and are ordered following two opposing trends:
· global (1) vs. regional (2); and
· market economy (A) vs. cooperation (B).

The four resulting scenarios are depicted below:
Main characteristics of the four scenarios for the Netherlands


Global Economy combines globalisation with individualism, whereas Regional Communities connects regionalism with cooperation. In the A-type scenarios, people tend to focus more on material values, whereas in the B-type scenarios, they focus on immaterial values. Likewise, in a 1-type world cultural and economic globalisation is an important trend where in a 2-type world the opposite is the case. Each combination of trends (i.e., scenario) has specific characteristics, which are summarised below. 

A1: The ‘Global Economy scenario assumes a continuing globalisation and liberalisation, resulting in high economic growth and a fast introduction of new technologies. In this capitalized, market-oriented and individualistic world civilians are strongly focussed on the material aspects of life. The welfare state crumbles off.
A2: In the ‘Transatlantic Market’ scenario the traditional bands between Western Europe and the United States are re-enforced and a strong cultural and trade block emerges. The differences between the Western world and other (less wealthy) regions increase. Traditions are important in this world, which shows itself in a society oriented towards self-sufficiency, an industry aimed at ‘improving the existing’ instead of radical changes and civilians aimed at family values, status and comfort. 
[bookmark: _Toc508775113][bookmark: _Toc40006911]B1: In the ‘Strong Europe’ scenario globalisation continues, not only aimed at removing trade barriers but also on exchange of knowledge and technologies between industrialised and developing countries. There is a general concern for the division of wealth and raw material between people and for the management of nature and the environment. Solidarity shows itself in the form of a strong welfare state.
B2: The ‘Regional Communities scenario assumes an emphasis on the own identity and self-sufficiency within a region. Global developments are not the general concern an receive less attention. People are less materialistic and more focussed on the quality of their living environment. Solidarity is important and the national government plays an important role in the division of wealth and the protection of collective interests.
This appendix also contains the basic assumptions and related spatial implications for the four scenarios. 

The scenarios are included in the land-use model in two ways:
1. They set regional or national land-use claims, by predicting a future surface area for every land-use type; and
2. They influence the relative importance of the factors that describe the suitability.

The table below contains the expected total surface area of each land-use type for the four scenarios. These are included in the model-version that will be used for the assignment. The figures in this table are derived from different sector-specific models and are based on the trends and assumptions for each scenario. They have been adapted to match the land-use changes between 2010 and 2017. As can be seen from the claim table, three of the four scenarios have a total land-use demand that is greater than the current land use, indicating over-demand. We solve this problem in our model by taking additional land from agriculture assuming that this function will be the weakest (least spending power) in the competition for space. 

A more extensive description of the related basic assumptions and spatial implications is listed in the large table on the following page.
Table 3 - Expected land use (hectares) in 2040 following the four scenarios, compared to the 2017 situation.
	[bookmark: _Hlk124844593]Land-use type
	A1 (GE)
	A2 (TM)
	B1 (SE)
	B2 (RC)
	Current (2017)

	Residential
	362,963
	337,498
	321,098
	292,486
	282,056

	Industrial
	118,250
	111,526
	104,803
	94,045
	91,356

	Recreation
	145,356
	135,158
	128,591
	117,132
	112,955

	Agriculture
	2,094,395
	2,136,781
	2,056,472
	2,099,543
	2,233,671

	Nature
	526,551
	526,551
	636,551
	636,551
	502,423

	Building lot
	-
	-
	-
	77,57
	25,053

	Infrastructure
	121,912
	121,912
	121,912
	121,912
	121,912

	Water
	3,147,677
	3,147677
	3,147,677
	3,1476,77
	3,147,677

	Exterior
	-
	-
	-
	-
	-

	Total (excl. infra & water)
	3,247,515
	3,247,515
	3,247,515
	3,247,515
	3,247,515


		Source: WLO (2006), adapted by SPINlab - Vrije Universiteit Amsterdam
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	Global Economy
A1_GE
	Transatlantic Market 
A2_TM
	Strong Europe
B1_SE
	Regional Communities
B2_RC

	Socio-economic conditions

	Economic growth
	Highest
	High
	Medium
	Low

	Population (2040)
	20 million
	17 million
	19 million
	16 million

	Households (2040)
	10 million
	8.5 million
	8.5 million
	7 million

	Societal focus
	Individual freedom
	Individual freedom
	Global cooperation
	Regional cooperation

	Recreation
	Not much spare time, emphasis on active leisure, accessibility and proximity to residential areas are important
	More spare time than in A1 and B1, emphasis is on rest & relaxation
	Valuable (more than in A1), people also like to go into nature areas, but some nature areas are restricted. Accessibility by road and by rail are important
	Valuable, people also like to go into nature areas

	General and sector-specific spatial policy

	Economic orientation
	Free market prevails, globalisation
	Free market prevails, protectionism
	Government intervenes, strong international institutions
	Government intervenes, strong local and regional institutions

	Spatial policy 
	Less restrictive policies 
	Less restrictive policies
	Restrictive policies for rural areas
	Restrictive policies for rural areas

	Agricultural policy
	Free world markets for agricultural products
	Internal EU support under conditions, no export subsidies
	Regulated world markets for agricultural products
	Internal EU support under conditions, no export subsidies

	Nature protection & development
	Only the most valuable natural areas are protected. 
International treaties are followed. Acquisition through private persons and organisations
	Symbolic role of the government, general trend: nature serves humanity.
International treaties are followed. Nature appears where agricultural land disappears. Nature is pushed aside by urbanisation processes
	Global environmental policy, strong international institutions. International treaties are followed and acquisition by national government following Ecological main structure (EHS)
	Larger areas protected, Ecological main structure realised. 
International treaties are followed and acquisition by national government following Ecological main structure (EHS)

	Agriculture and nature conservation
	Strong decline of agricultural land use. No chances for agriculture combined with natural values
	Agricultural land use remains the same or decreases slightly.  No chances for agriculture combined with natural values
	Agricultural land use remains the same or decreases slightly. Room for agricultural nature management
	Decline of agricultural land use follows historic trend.  Diversified rural development, much room for agricultural nature management

	Water management
	Building near rivers is allowed
	Building near rivers is allowed reluctantly
	Restrictions on urbanisation in designated areas
	Restrictions on urbanisation in designated areas

	Expected spatial developments

	Urbanisation
	Urban sprawl in rural areas. Accessibility by road to and from urban areas is important. Attractive surroundings are important for residences.
	Urban sprawl in rural areas. Accessibility by road to and from urban areas is very important. Proximity to an airport is important. Attractiveness of the surroundings is not important
	Concentration near existing urban areas, no new residential areas near airports
	Concentration near existing urban areas, no new residential areas near airports and in low-lying rural areas

	Commercial functions
	Abundant growth, preference for highway locations
	High growth, strong preference for highway locations
	Medium growth, public transport accessibility promoted, also preference for highway locations
	Limited growth, public transport accessibility strongly promoted


Basic assumptions and related spatial implications for the scenarios

Appendix 3	Overview of available spatial data - Land Use Scanner Student Edition
	Spatial data Land Use Scanner – demo

	Main group/ Theme
	Data layer
	Spatial data description
	Units

	Current_landuse

	
	Predominant
	Representation of predominant land use per grid cell in any of nine classes described below
	[0..8 classes]

	
	residential
	Residences and related activities, including:
· public parks < 1 hectare, streets and parking lots
· small playing fields, children's farms, gardens
· primary facilities: shops, schools
· small offices of e.g., banks 
· shopping malls, hotels and restaurants incl. parking lots
· public or social-cultural facilities, e.g., high schools, hospitals, museums, churches, cinemas, conference centres
	[0 to 1 Ha]

	
	industrial
	Industrial land use, including:
· industrial or commercial areas, such as harbours, distribution centres wholesale trade market, office buildings incl. parking lots, auction site, factory outlets, 
· extractive industries (sand pits, gravel extraction etc.)
	[0 to 1 Ha]

	
	recreation
	Recreational areas, including:
· parks, public gardens and playing (sports) fields
· allotment gardens
· day trip locations (amusement parks, zoos etc.)
· short and long stay facilities (campsites, caravan parks, holiday parks etc.)
· cemeteries
	[0 to 1 Ha]

	
	nature
	Nature and forest areas, including:
· broad-leaved and coniferous forest
· saline grassland, beaches, dunes, heath land
· peat land and moors, swamps, bare soil
	[0 to 1 Ha]

	
	agriculture
	Agricultural land use, including:
· arable farmland and horticulture (e.g., potatoes, beets, cereals, flower bulbs and greenhouses)
· grassland, (zero-)grazing livestock and orchards
	[0 to 1 Ha]

	
	building lot
	Grounds prepared for new buildings or other developments
	[0 to 1 Ha]

	
	infrastructure
	Railway, roads, airports and semi-paved terrain (including dump sites, wreck storage zones)
	[0 to 1 Ha]

	
	water
	Fresh and salt water, including:
· water storage basins, lakes, rivers, sea
· recreational water
· reservoirs and water for extractive industries
	[0 to 1 Ha]

	
	exterior
	Land use outside the Netherlands that is not simulated in Land Use Scanner
	[0 to 1 Ha]




	Policy_maps

	Spatial_plans
	residential
	Spatial development plans for new residential areas
	[Present: 1 or 0]

	
	industrial
	Spatial development plans for new commercial areas
	[Present: 1 or 0]

	
	recreation
	Spatial development plans for new recreational areas
	[Present: 1 or 0]

	NatureLandscape
	birdHabitat
	Land protected under European directive for the natural habitats of birds and endangered species
	[Present: 1 or 0]

	
	net_EHS03
	National Ecological Network; protected network of Natural areas that in part has yet to be acquired
	[Present: 1 or 0]

	Water
	intake_reservoir
	Areas designated for water storage in case of prolonged local rainfall
	[Present: 1 or 0]

	
	disaster_retention
	Areas designated to store river water in case of anticipated floods to protect areas downstream
	[Present: 1 or 0]

	
	space_for_rivers
	Areas reserved by National Government for widening of river flood plains
	[Present: 1 or 0]

	
	groundwater_protection
	Ground water protection zone designated by regional authorities (fraction of cell within policy zone)
	[Ratio: 0 to 1]

	
	groundwater_intrusion
	Ground water intrusion areas that currently are not fully protected (fraction of cell belonging to this area)
	[Ratio: 0 to 1]

	Thematic_maps

	Residential_locat.
	urban_attractiveness
	Index expressing relative richness in: cultural facilities; hotels & catering outlets; and shops
	[%]

	
	attractive_surroundings
	Indicator of landscape attractiveness as perceived by general public
	[%]

	Accessibility
	dist_mainports
	Average Euclidean distance to mainports Schiphol airport and Rotterdam Harbour
	[km]

	
	dist_trainstation
	Euclidean distance to nearest railway station (passenger stations in use in 2010)
	[km]

	
	dist_highwayentry
	Euclidean distance to nearest highway entry (National Road Database, 2012)
	[km]

	
	dist_100000inh
	Euclidean distance to nearest 100,000 inhabitants, aggregated to 4-digit zip code level (2009)
	[km]

	
	dist_100000jobs
	Euclidean distance to nearest 100,000 jobs, aggregated to 4-digit zip code level (2009). 
Source for employment figures: ABR Regiobase (Statistics Netherlands, 2009)
	[km]

	Noise
	perc_opp_gt_50dba
	Fraction per cell with a noise level exceeding 50 dB(A)
	[%]

	NatureLandscape
	landscape_quality4K
	Landscape values as perceived by experts in 4 classes [low, medium, high, very high]
	[0 .. 3 classes]

	
	landscape_experience
	Attractiveness of landscape as perceived by general public [strongly negative, ... highly positive]
	[-4 .. 5 classes]

	
	altitude
	Elevation at ground level
	[m]

	Safety
	floodWaterDepth
	Average water depth resulting from the worst possible flood (www.risicokaart.nl)
	[m]

	
	earthquakes
	Location prone to earth quakes with different intensities (6.0, 6.5 or 7.0) on the Mercalli scale
	[0 .. 3 classes]

	
	dangerous_sites
	Fraction of cell area within a risk zone or immediate vicinity (100m) of a dangerous facility (e.g., chemical factory, storage facility for explosive material)
	[Ratio: 0 to 1]

	
	dangerous_transport
	Fraction of cell area within the immediate vicinity (100m) of a pipeline transporting dangerous goods
	[Ratio: 0 to 1]

	Distance_Decay

	LandUse2010
	Land-use types in range of 1, 5, 25 and 50 km
	Relative amounts of specific land-use types that can be found within different distance ranges. Calculated by applying a square root distance decay function that gives less weight to larger distances from the observed cell. Similar to moving window filters in GIS 
	[Ratio: 0 to 1]

	PolicyMaps
	birdHabitat area within 1km
	Fraction of the area within a 1-km range that is designated as part of the BirdHabitat directive area (calculated by applying a square root distance decay function)
	[Ratio: 0 to 1]

	
	net_EHS03 area within 1km
	Fraction of the area within a 1-km range that is designated as part of the National Ecological Network (calculated by applying a square root distance decay function)
	[Ratio: 0 to 1]
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